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Why Bibliography Management?

Source: Output:
\begin{filecontents}{\jobname.bib}
@BOOK{ Foo:2012a, Hello World [1, 2, 3]

title = {My Title},
publisher = {My Publisher},
year = {2012},

, author = {Author} References

@ngﬁ?:“%g;z?; o [1] Author. My Title. My Publisher, 2012.
publisher = {My Publisher},
year =L, [2] Author. My Title. My Publisher, 2012.
author = {Author}

¥

[3] Author. My Title. My Publisher, 2012.

@BOOK{ foo:2012c,
title = {My Title},

e e Duplicated References may come from the
i i - i) .

author = {Author} following reason:

}

\end{filecontents} 1. Carelessness
\documentclass{article} 2. Collaboration

\begin{document} . . L.

Hello World \cite{foo0:2012a, f00:2012b, foo:2012c} 3. Extension of an eX|st|ng work
\bibliographystyle{plain}

\bibliography{\jobname} LaTeX cannot detect them
\end{document}
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Register for a Zotero Account

You have to create an account first in order to use Zotero
and join our group

Go to the URL https://www.zotero.org/
Click the register link
Follow the instructions to finish the registration
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' Zotero | Home x\+
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Install Zotero

« The downloading page is https://www.zotero.org/download/

« Zotero has the Standalone software and plug-ins for web
browsers. I suggest you install all of them.

Zotero for Firefox Zotero Standalone
Zotero for Firefox lets you capture and organize all Zotero Standalone runs as a separate application and
your research without ever leaving the browser. plugs into your choice of browser.
- ) Install Zotero for Firefox ( : Download Zotero for Windows
>
Add a plugin for Word or LibreQffice Next, add one of the following browser extensions:
Trouble installing Zotero? w :*Hm : ¢ EEiE—.ii
OO ez - Plugins for Word and LibreOffice are included
= -
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Install better BibTeX Plug-in (Important)

- For backward compatibility, you have to install better BibTeX so the item keys in previous
BibTeX management website are consistent with the keys in Zotero (otherwise Zotero
generates its own keys).

« The URL is https://github.com/retorquere/zotero-better-bibtex
« The latest release is https://github.com/retorquere/zotero-better-bibtex/releases/latest

« The installation file is a Firefox plug-in. Firefox ought to start installation by double clicking.

For standalone Zotero, do the following: r
1. In the mai to Tools > Add S
. In the main menu go to Tools -ons *hE #E0 [IED) =50

2. Sglect Exten5|ons. . ~ & @ |0 4

3. Click on the gearin the top-right corner and choose 'Install N pree—— RIFEE. | o
Add-on From File...' I My Publica Add-pns 3vc

4. Choose .xpi that you've just downloaded, click 'Install - ;’;;E* = am

5. Restart Zotero sozen ‘ 5 oo

24F

Ol =i

The complete installation TN
instructions can be found at
http://retorque.re/zotero-better- : _

. . . . Zotero Better Bib(La)Tex i
b|bteX/|nSta”at|On/ Ap;:learance Make Zotero useful for us LaTeX holdouts. More <

- - ) . R ¥ Update Aaa- utomatically
= Plugins @ Zotero LibreOffice Integration Reset All Add-ons to Update Automatically

Integrates Zotero with LibreOffice and OpenOffice.org 3.0 or later ~TIGTE
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Log in Your Account in Zotero

There are several ways to use Zotero.
You need to log in them respectively.

« For the website, go to the log in page
directly.

« For the standalone version as well as
the browser plug-in, you need to

select the Preferences and go to the Pass

Sync tag. Then enter your username
and password.

« The sync function can upload the PDF
file automatically and you have
300MB free space for your own.

« Uncheck the uploading function for
Group if you do not want to pay for
extra space (USD 200 for a year).

Preferences
1 Zotero BiE
i i =
r'a.',;l:;' =/ @ ﬂ E
=3 g & S 31
™
a2 (== Sync

Zotero [F S

User =~ ETEE

E N, eessessesee

Shil=E-
EEFEAE

i i
[ B raiEEraals, 5B | Zotero

RS | RS

Zotero EIEERSEHETEE A

T Cloud Storage

EHiFEFHZotero =8, (HEF TR S5008H




Join MTrec Group

[ z Zotero

8 &

v([3 EHIEE
My Publication
Zoterofg*
T EEEHE
FoEER
0 =t

A5 smwate Group

(

Mtrec Repository

T Bl

v[@ mTrec  Bibliography

4

ums  GetInvolved

Home > Groups > MTi b
@
(& Library Title
Mtrec Repository 3480 compatible tape subsystems meet demands for midrange s
[G@ Trash & 3VQM: A vision-based quality measure for DIBR-based 3D video.

« Tell me your username and I will invite you
to our group (MTrec).

« Afterwards you can visit our group on the
webpage or on the client side.

« You can ADD, EDIT and REMOVE items. Be
careful when you do this because the other
users in this group will also be affected.



Group Item and Your Personal Item

« Only the items in the group bibliography
will be uploaded to the cloud.

« To share your bibliography items, simple
drag the item from your directory to the
group directory.

« Similarly, to download items from our group,
simple drag the items from the group
directory to your own directory.
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Add a New Item from Browser

Collaborative Wireless Fre: % | +

€& | OB iccexploreiese.org/document 7384509/ c =

= B3
ﬁg¢-ﬁ-uez()5

Related Articles

Browse Journals & Magazines - IEEE Transactions on Multimed... = Volume: 18 1ssue: 3 @

Collaborative Wireless Freeview Video Streaming With
Nemork COding Net'{\rorl-( Coding for Distributed Storage
Systems

| 4 321
[ A Survey on Metwork Codes for Distributed
View Document Paper Full Stmag;

i Citations Text Views

R2: Random Push with Random Network
Coding in Live Peer-to-Peer Streaming

' View All

4 ~ Bo Zhang ; ~ Zhi Liu ; ~ 5-H. Gary Chan ; » Gene Cheung Wiew All Authors
Author(s)

« You can manually add items, but I strongly suggest you use the
plug-in to avoid mistakes.

« Simply go to the related webpage of the paper (e.g. IEEExplore
or ACM digital library) and click the save button.




Add New Items from a BibTeX File

D
File ((ZE®) *s0 120 =0
—_—

FEZHE r |@~ A
D =]
gL o8 Walkie
I & LiTell: r
mpor 7 Deepfa
Ctrl+5Shift+1

N ABRESA Cilsshifesal A robu

e T I -

Import froi WiFi in
. Augme
Clipboard | _. = WiF: ar
———— 2 A hybri
Resource M £

« Method 1: Go to File -> Import and follow the instructions.
* Method 2: Copy the text from the file (i.e., Ctrl + C) and choose File ->
Import from Clipboard.
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Export items from Zotero to BibTeX

rz Zotero
P s E‘t-FiIlIr‘I P — p— oy L | I . Fas
X E FEE IRD =wE) optim] = EXpoOrt
; # y Mana -
‘ st |L‘*ﬁi':= Better BibTeX ~
Better BibLaTeX

|
M s er i 1eA Quick Copy
Better CSL JSOM

H Better CEL YAML
"1 K] BetterBibTeX JSON
BibLaTeX
Bibliontology RDF
BibTeX —

|

BibLaTeX url Bookmarks
. COinS
Report Better BibTeX Errors...

« If you are preparing references for a paper, create a new
directory for the paper and drag the related work into it.

« Right click the directory and choose Export option. In the sty/e
option choose Better BibTeX option instead of BibTeX.




Contents

1. Why Bibliography Management

2. Install Zotero with Better BibTeX

3. Add a New Bibliography Item

4. Export Items From Zotero to BibTeX
5. Better BibTeX & Duplicated Items

6. Online Tutorial Videos




Citation Key & Duplicated Items

o & G- Q- A b F-| A B & B - @
| FAErE el - HEE 5 |8 | 28 | e | xEm |
I | My Publication 5" BRITE: Universal Topology Generation fr... Medina &. = T n
| ZaterofH Broadcast-Based Peer-to-Peer Collabora... Leung 1 Chan —_ -
 EE=HE Broadcasting in Multi-radio Multi-chann... Ren £ ‘
FHEEE Broadcasting Video with the Knowledge ... Chan # Yeung = ucket—Fil!ing: An .
0 [k 7" BubbleUp: Low Latency Fast-Scan for M... Chang # Garci... (M ﬁﬂﬁ?ﬁf&;gﬂ;:gﬁf
M ) Bucket-Filling: An Asymptotically Optim... Chang #I Chan « #&: Chang Zhangyu - g E
v g BHEEE ‘ 7 Buffer Architectures and Routing Algorit... Chan ¥ Kobay... . Chan. S.H.G -
V(@ MTrec i| 4 Buffering and Caching in Large-Scale Vi... Dan £ T 'I"EE‘: Chan. 5.-H. Gary &
. _Mirec Repository | @ Building A Monitoring Overlay for Peer-t... Jin £ = )
dU pl |Cated : Building heterogeneous peer-to-peer ne... Kwong #1 Tsang i ﬁiﬁt:;aer;:dlons en | 8
|tems 7 Building multicast trees for multimedia s... Tan #] Datta & 17
e S 1| &Y Bullet: High Bandwidth Data Disseminati... Kostic .
I 3DTv 802.11 network CACAO Nictribibad Chant Aecictad Cha  Via S M. 5

« Zotero cannot save the BibTeX key. To fix this, better BibTeX store
the key in the extra field in the form bibtex:[key].

« Zotero can automatically find the duplicated items. You can check
them in the directory and merge them if necessary.

 Papers may happens to have same name (e.g., conference versus
journal). Be careful!




Duplicated Items (Cont'd

A case for end system multicast

A case for end system multicast

» A comparison of Pedestrian Dead-Reckoning algorithms using a low-cost MEMS IMU

A comparison of Pedestrian Dead-Reckoning algorithms using a low-cost MEMS IMU

A Double-Step Unscented Kalman Filter and HMM-Based Zero-Velocity Update for Pedestrian Dead Reckoning Using MEMS Sensors
A Double-Step Unscented Kalman Filter and HMM-Based Zero-Velocity Update for Pedestrian Dead Reckoning Using MEMS Sensors

» A localization system using inertial measurement units from wireless commercial hand-held devices

A localization system using inertial measurement units from wireless commercial hand-held devices

A Step, Stride and Heading Determination for the Pedestrian Navigation System

A Step, Stride and Heading Determination for the Pedestrian Navigation System

A Zero Velocity Detection Algorithm Using Inertial Sensors for Pedestrian Navigation Systems

A Zero Velocity Detection Algorithm Using Inertial Sensors for Pedestrian Navigation Systems

Accurate Step Length Estimation for Pedestrian Dead Reckoning Localization Using Stacked Autoencoders

Accurate Step Length Estimation for Pedestrian Dead Reckoning Localization Using Stacked Autoencoders

i An UWB relative location system

An UWSB relative location system

Average Step Length Estimation Models’ Evaluation Using Inertial Sensors: A Review
Average Step Length Estimation Models” Evaluation Using Inertial Sensors: A Review
Can internet video-on-demand be profitable?

Can Internet Video-on-Demand be Profitable?

Can ISPS and P2P users cooperate for improved performance?

Can ISPs and P2P users cooperate for improved performance?

i Centralized channel assignment and routing algorithms for multi-channel wireless mesh networks

« Zotero can automatically find the duplicated items. You can check them
in the directory and merge them if necessary.

~ BIEE
Chu &,
Sanjay £,
Jimenez &,
Jimenez &,
Tong &,
Tong &,
Mikov £,
Mikov £,
Kim &,
Kim £,
Park # Suh
Park #1 Suh
Gu s,
Gu &,
Correal &,
Correal £,
Vezoénik #1 Juric
Vezoénik # Juric
Huang £,
Huang &,
Aggarwal £,
Aggarwal &,
Raniwala £,

RInE 5

2017/5/13 F456:01:47
2017/5/13 R&6:01:47
2020/6/3 £410:47:22
2020/6/3 F512:43:23
2020/6/3 E£510:54:40
2020/6/3 F412:09:06
2020/5/2 T43:58:53
2020/5/2 T454:27:26
2020/5/2 T43:58:53
2020/5/2 T454:27:26
2020/5/2 T43:58:53
2020/5/2 54:27:26
2020/6/3 £510:33:15
2020/6/3 F511:43:59
2020/5/2 T43:58:53
2020/5/2 T44:27:26
2020/5/2 T453:58:53
2020/5/2 F54:27:26
2017/5/13 F&6:01:47
2017/5/13 R&6:01:47
2017/5/13 F46:01:47
2017/5/13 ’46:01:47
2017/5/13 F46:01:47

« Papers may happens to have same name (e.g., conference versus

journal). Be careful!

> PDRComparison...
) unscentedPDR1...

Citekey
Narada02 ¢
SanjayQ2acase *

' PDR-compariso...

o unscentedPDR1...

5 Mikovlocalizatio... |
) KimStepStrideH...

' Mikovlocalizatio...

5 KimStepStrideH...

5 ParkZeroVelocit...

' ParkZeroVelocit...

' GuAccurateStep...

5 PSLEAutoencod...

) CorrealUWBrela...

5 CorrealUWBrela...

' VezocnikAverag...

o VezocnikAverag...

huang2007can ¢
citeulike:223859...
Aggarwal2007 ¢
AFS07 ¢
RGC04 ¢

a

>

m




Citation Key Management (Important)

Rules to add items into our group library

1. If you are the first one that add the item, you have the right
to decide the citation key. If you do not give a key, the
system will automatically generate one for you.

2. If you add a new item (or a batch of items), always check the
duplicated items. If the item already exists, you are
responsible to remove your duplicated items.

3. You have make sure that the citation key of your paper in
our SVN is consistent with the citation key in our group
library.




We have record on who adds the item

+ 200 &O

Title

S A ey T g e S e

802.11 user fingerprinting

802.11 wireless networks: the defi...
A 10<sup>13</sup> bit optical d...
A bandwidth management techni...
A barometer-assisted method to ...
A broadcasting protocol for com...

A bubble oscillation algorithm for...

A caching-based video-on-dema...

A case for end system multicast
A case for end system multicast

A case for end system multicast

[ A case for redundant arrays of ine...
A case study of a pull WAP locati...

[ A channel assignment algorithm f...
A cloud-oriented content delivery...
A comparative analysis of disk sc...

A comparison of Pedestrian Dead...
[ A comparison of Pedestrian Dead...
A comparison of resilient overlay ...
A comparison of sender-initiated ...

A constrained least squares appro...

i}

~  Creator

Pang et al.

Gast

Ammon and Hoover
Z.Wang and A. Hua
Ying et al.

Paris

Du et al.

Xie and Hua

Chu et al.

Chu et al.

Sanjay et al.

Patterson et al.
Sanchez et al.
Avallone and Akyildiz
Papagianni et al.

J. Teorey and B. Pinkerton
Jimenez et al.

Jimenez et al.

Birrer and Bustamante

Towsley et al.

Cheung et al.

1997-06-03
2016-03
1999-04-26
2004-03
2009
2002-10
2000-06
2002

1988

2009
2007-08
2013
1972-03
2009-08
2009-08
2007-12
1997-04
2006

Date Added

2018/5/21 E&F2...
2017/5/13 6.
2017/5/13 TF6....
2017/5/13 T4&6....
2018/5/9 FH12....
2017/5/13 6.
2017/5/13 T&F6....
2017/5/13 F56....
2017/5/13 F&F6....
2017/5/13 6.
2017/5/13 F&F6....
2017/5/13 F&6....
2017/5/13 F&F6....
2017/5/13 T&F6....
2017/5/13 F46....
2017/5/13 F&6....
2020/6/3 E4F10:...

2020/6/3 F&F12:

2017/5/13 T56....
2017/5/13 F4&6....
2017/5/13 T&F6....

hanlc1993

changzhangyu
changzhangyu
changzhangyu
khchowad

changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
changzhangyu
SteveZhuo

SteveZhuo

changzhangyu
changzhangyu

changzhangyu
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Online Tutorial Videos

1. Installing Zotero Standalone:
https://www.youtube.com/watch?v=H8UTehdF92s

2. Installing the Firefox Extension:
https://www.youtube.com/watch?v=SDjFzX2kdHc

3. Synchronization:
https://www.youtube.com/watch?v=3IFQEvNMXuM

4. Using Zotero:
https://www.youtube.com/watch?v=mP5AzJHXTIA

5. Zotero Group Library:
https://www.youtube.com/watch?v=3QKF25nmnds

6. Better BibTeX:
https://www.youtube.com/watch?v=GAVXVkcpbGO
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